What’s New in TeamForge
New Features and Functionality

Last Updated: 4/30/2020
Introduction

Digital.ai is committed to its customers, the quality of their user experience, and the accuracy and availability of their historical data. We continuously strive to enhance their projects' traceability from planning through design, development and delivery. In accordance with these precepts, we continue to enhance TeamForge’s® ability to help leading companies and government agencies accelerate application development and delivery while maintaining the highest standards of governance, compliance and intellectual property security.

The following slides highlight these enhancements in reverse chronological order, with the latest release at the top of the presentation.
TeamForge 20.0 Release Focus

- TeamForge Baselines
- Trackers
- Documents
- Webhooks
- Integrations
- GitAgile™ – Enterprise Version
TeamForge Baseline – Database Migration Issue Log

You can now add log entries for Baseline Database Migration issues.

Use the `BASELINE_LIQUIBASE_LOGLEVEL` token and set it to `debug` to log these issues if any occur during baseline database migration.
Trackers

With TeamForge 20.0, you can easily manage single- and multi-select custom field values.

- Over time, the list of valid choices for a single- or multi-select custom field may change, obsoleting specific values.
- Because these obsolete values may have been selected for various Tracker artifacts, it is unwise to delete the values from the list.
- Now, these values can be hidden in the list using the Visible box in the Values section of the Tracker field definition.
- Access this via the Project Admin > Tracker Settings page.
Documents

The Documents List page can now be viewed in two formats using the New Documents toggle button at the top right corner of the Documents List page.

New Features and upgrades include:

- Tag Cloud
- Documents Search using @user and #status
- Left Navigation pane
Documents – New Documents List Page

The Documents List page can now be viewed in two formats using the **New Documents** toggle button at the top right corner of the Documents List page.

You now have the option to toggle between the Enhanced Documents List Page and the familiar one from previous versions.

NOTE: More detail about the Enhanced Documents List page can be found in the 19.3 slides in this presentation, and in the TeamForge Help Center.
Documents – Tag Cloud

While tag creation and management remain unchanged, TeamForge 20.0 now introduces tags as a means of navigation and classification and with the Tag Cloud.

- The Tag Cloud is a group of tags found in the left navigation pane of the Documents List page. You can filter documents by tag.

- The Tag Cloud shows the most recently used tags
- Click a tag to list all documents associated with that tag
- Click All Tags to view all the tags in the Documents List page
- A tag in the tag cloud is indicated with its size and shape
- A bigger font size and darker shade means that more documents are associated with the tag
Documents – Documents Search @user & #status

The new Documents List page’s search function now supports @user and #status simple search.

- The @user simple search looks for documents and folders last edited by a specific user.
  - Username predictions are shown as you type @ followed by at least two characters of the username in the Search text box.

- The #status simple search looks for documents and folders that are in a specific status.
  - A list of available statuses are shown as you type # in the Search text box.
Documents – Additional Documents List Page Info

Visit the TeamForge Help Center for more details on these Documents List Page enhancements:

• The New Left Navigation Pane
• New Action Icons
• Concatenation of the Document Name and ID
• Documents List Page Shows Both Folders and Files
• Monitor and Unmonitor Document Folders and Documents
• Add New Subfolders/Rename Documents and Folders
• Move or Copy Documents and Document Folders
• Lazy-loading of Document Folders and Documents
• Default Document Column Configuration
• Search Document Folders and Documents
• Recent Documents
Webhooks

Here’s What’s New with WEBR (Webhooks-based Event Broker):

- The TeamForge-WEVR 20.0 REST API Documentation is now available.

- Two new WEBR site-options.conf tokens have been added. See our TeamForge 20.0 docs for site options tokens details.:
  - `WEBR_HTTP_BINDNAME` which lets you bind the WEBR service to http and to any other port of choice.
  - `INIT_JSFFILE` which lets you load an initial Javascript (JS) file to the WEBR’s native JS virtual machine.
Integrations

With TeamForge 20.0, integrations have been updated as follows:

- Traceability between TeamForge Requirements and TestLink Test Suites is shown in the Association Viewer.
- A new plugin is available to manage unwanted Nexus privileges which accumulate with each new repository.
- Post-submit webhooks let you integrate TeamForge with other diverse applications that support webhooks.
  - E.g., TeamForge to Jira and Jira to TeamForge.
GitAgile™ - Enterprise Version Control

The TeamForge – Git integration is now based on Gerrit version 2.15.18.

As of TeamForge 20.0:

- UserFilter removal - direct outcome of the removal of the `current_user` predicate from the open source Gerrit. Existing rules with User Filter continue to work but must be updated post TeamForge 20.1 when UserFilter support will no longer be available.

- Submodules Tab – added to the repository settings page. Allows you to view a list of all submodules used in the project.
GitAgile™ - Enterprise Version Control (cont.)

As of TeamForge 20.0 (cont.):

- Expose Quality Gate Rules to All Repositories – these rules are now stored in the `ref/meta/config branch` of the TF-Project repository which allows TeamForge Admins to simply modify this branch and push the changes to the repository to have the quality gate rules available to all repositories.

- Configure Advanced Repository Settings During Creation/Import – new `Create` and `Import` tabs allow entry of a repository name and selection of destination server to create/import the repository. There is now a `Settings` toggle button available for showing advanced repo settings which can be used to configure the repository settings.
Install / Upgrade

- EventQ End of Life – EventQ is no longer supported as a TeamForge service.
  - All the reports (for example, some of the Activity Reports) that use EventQ datastore are deprecated.
  - All EventQ-enabled integrations such as integrations with Jira, Jenkins and so on are deprecated. As an alternative, you can create integrations via the TeamForge Webhooks-based Event Broker (WEBR).
  - All EventQ related site option tokens are deprecated.
  - Do not discard your EventQ data. Back up your EventQ database before you upgrade.
Install / Upgrade (cont.)

- The `yum install teamforge-baseline` command – installs both the database and baseline packages. If you do not install the TeamForge Baseline service, you must use the `yum install teamforge-database` command to install the database packages.

- New Site Option Token – `HAPROXY_HTTP_REUSE_OPTION` has been added to the `site-options.config` file for HAProxy configuration.
  - This token is used to declare how idle HTTP connections can be shared between requests.

- Call Back URLs – lost when you restart WEBR which means a TeamForge/Jboss restart must follow immediately after you stop or restart WEBR.
Install / Upgrade (cont.)

- TLS Protocol Versions 1.0 and 1.1 – software industry including popular browsers (e.g., Chrome, FireFox, etc.) is set to deprecate the TLS protocol versions 1.0 and 1.1. TeamForge is following suit and deprecating these versions of the TLS Protocol.
  - Upgrading your site(s) to be able to negotiate with TLS 1.2 connections is advised.

- Self-signed SSL Certificates with Subject Alternative Name (SAN) - It is typical of browser clients not to trust self-signed SSL certificates that do not have the Subject Alternative Name (SAN) configuration.
  - Configuring the `PUBLIC_FQDN` token in TeamForge is necessary to have SAN/DNS entries configured in the self-signed SSL certificate you generate.
TeamForge 19.3 Release Focus

- TeamForge Baseline
- My Workspace
- Trackers
- Documents
- File Releases
- Reports

- GitAgile™ – Enterprise Version
  Control
- TeamForge CLI
- Site Administration
- Project Administration
Release Focus - TeamForge

With Release 19.3 of TeamForge, we have focused on the following areas for enhancements, changes and additions:

- TeamForge Baseline
- My Workspace
- Trackers
- Documents
- File Releases
- Reports
- GitAgile™ – Enterprise Version Control
- TeamForge CLI
- Site Administration
Baselines – Export to Excel

You can now export all approved Baselines (item) and Project Baselines using the Export to Excel option on the View Baseline or View Project Baseline page.

The name of the downloaded Excel file has the format “[baseline_id]baseline_name”

Example: If you export the baseline “export_baseline” with the id of “base1015” the name of the resultant excel file will be “[base1015]export_baseline”

If the name includes a special character other than an underscore or it includes a space, it will be replaced with an underscore in the name.

The Excel file has worksheets for each component included in the exported Baseline or Project Baseline. Each worksheet has as many number of columns as the manifest fields for each component.
My Workspace – Documents Widget

You can now add the **Documents widget** to your **My Workspace** page using the **Add new widget** page.

On the **Documents widget**, edit the configuration (gear icon) and select the criteria to identify documents to list on the **Documents Widget**.
Trackers

Here’s what is new with Trackers:

- Attachment Reminder
- Handling Simultaneous Updates
- Support for Tracker Artifacts with Parent Artifacts in Backlog Swimlane of Task Board
Trackers – Attachment Reminder

The **Attach Reminder** feature alerts you when you submit an artifact before attaching files.

The alert is triggered by key phrases/words which may appear in the **Description** field or **Comment Text** field.
Trackers – Simultaneous Updates

Until TeamForge 19.3, updating a Tracker artifact which has been updated simultaneously by another user prompted a version mismatch error directing you to reload the page thus losing your changes.

Now, the **Overwrite** feature will prompt you to add your changes, overwriting the other user’s changes or to cancel to view the other user’s changes.
Trackers – Parents in Backlog

Previously, only Tracker artifacts without parent artifacts were displayed in the Backlog Items swim lane of a selected planning folder on the Task Board.

Now, all artifacts which have parent artifacts are also shown in the Backlog Items swim lane. On other words, the Backlog Items swim lane now shows all the artifacts irrespective of their dependencies.
Documents – Documents List Page Beta

The Documents list page has been redesigned for a better user experience.

You can toggle between the familiar and the redesigned Document List pages using the Try the Beta toggle button.

Important: The features covered on the redesigned Documents List page are supported only on Google Chrome and Mozilla Firefox browsers.
Documents – Documents List Page Beta (cont.)

With the Beta, the left navigation now shows the following options:

**All Files** – By default, the root document folder contents are displayed in the Documents list view. As you access other folders, the last folder used will be the folder structure displayed on your next use.

**Recent Files** – When selected, displays the recently added, modified and viewed documents.

**Favorites** – when selected, displays the documents set as favorites.
With the Beta, the document name and id are grouped and shown under the single Name column with the document id as an active link.
The action buttons for performing operations such as monitoring, move and copy in the existing Documents list page are changed into action icons and placed at the top of the redesigned Documents list page (beta).

The bell icon represents the monitoring feature and the more (...) option captures the operations such as New Folder, Rename, Move/Copy, Download and Monitoring Users.
The following are additional new features and enhancements to the Documents List page (beta):

- Inclusion of Document Folders – previously, only documents were listed. Now sub-folders display in the list.
- Monitor and Unmonitor Document Folders and Documents – toggle between the grey (Unmonitor) and the blue (Monitor) bell icons
- On-scroll Display of Document Folders and Documents – the list is now displayed with scrolling vs. the former pagination
- Configure Default Document Columns – now enhanced for better user experience
- Search Document Folders and Documents – use the search icon to search the list
- Recent Document Files – access recently added, modified and viewed documents from the left navigation menu
File Releases – Audit Change Log

You can now track changes to a select file release from the Change Log. This log tracks:

- Changes to the name, description, status, or maturity of a file release
- Addition or removal of associations to a file release
- When a file is added, updated or deleted in a file release
Reports – Multiple Planning Folders

Until 19.3, Tracker reports in a project addressed only one planning folder. Now, you can select multiple planning folders across multiple projects.
Here’s what is new with GitAgile™:

- Download Folders from a Git Repository
- Support for Relative Paths
- Ignore Whitespace in Code Diff View
- Configure Checkout Command for Git Repositories
- Support for Unified Diff View of Images in Code Browser
- Inclusion of LFS Data in Downloaded Zip Archives of Git Repositories and Repository Tags
GitAgile™ - Download Folders from a Git Repo

With 19.3 you can not only download individual files, but also the folders from a Git repository.

Use the new Download this folder as a ZIP file icon on the View tab of the Code Browser

To download an individual file or folder, simply navigate to that object and use its ZIP file icon
GitAgile™ - Support for Relative Paths

You can now add relative paths of files, folders, and images either as inline-style links or as reference-style links to the markdown files from within the Code Browser.

When you add the relative path of an image in the markdown file, the image file is rendered on saving the markdown file.

When you add the relative path of a file or folder in the markdown file, a link to the file or folder is added on saving the markdown file.
GitAgile™ - Ignore Whitespace in Code Diff View

A new Ignore whitespace option has been implemented in TeamForge 19.3 to remove leading, trailing or interspersed whitespaces in your line of code while viewing the differences in your Code Browser.

This option is enabled by default.
GitAgile™ - Configurable Checkout Command

You can modify the checkout command settings for both HTTPS and SSH protocols to include either the SCP-based or cURL-based commit message hook in their clone URL.

This uses two new parameters (on the Admin>Integrations> <Git hostname> page) and applies across projects on your site:

- HTTPS HOOK FETCH COMMAND
- SSH HOOK FETCH COMMAND
GitAgile™ Unified Diff View of Images

It is now possible to compare the differences between versions of an image file in the unified diff view of the Code Browser.

There are two modes of viewing differences between image versions:

- **Image Opacity** – default; use the Revision image opacity slider to increase or decrease the opacity of both the base and revised images.

- **Highlight Image Differences** – not supported in Microsoft Internet Explorer; you can switch to this mode to highlight the changes in the revised image using a color or transparent mode.
TeamForge CLI - Enhancements

The latest TeamForge CLI version 1.9.12.3 is now available and includes the following enhancements:

- Support for all methods of TeamForge related REST API calls – GET, PUT, PATCH, POST, DELETE, OPTIONS, AND HEAD
- `validjson` command has been introduced to validate JSON content which can be passed as request content or returned as response content in REST API calls
- `printjson` command has been introduced for pretty-printing JSON content for easier reading
The enhancements to the Admin > System Tools > Ad Hoc Database Query page focus on support for Baseline and TeamForge Webhooks-based Event Broker Databases.

Two new data store options, Baseline and WEBR, have been added to let you query your targeted database.
Project Admin – Tracker Pre-Submit Webhooks

- Pre-submit event type messages can now be sent to the TeamForge Webhooks-based Event Broker after validating the defined business rules on Tracker artifact updates where previously, only post-submit messages were supported.

- Pre-submit event types are called as **SYNC** event types.

- Post-submit event types are called **TOPIC** event types.

- The Project Admin > Webhooks > Create Webhook page has been redesigned to accommodate both event types.
TeamForge 19.2 Release Focus

- TeamForge Baseline
- Integrations
- Trackers
- Documents
- File Releases
- GitAgile™ – Enterprise Version Control
Release Focus - TeamForge

With Release 19.2 of TeamForge, we have focused on the following areas for enhancements, changes and additions:

- TeamForge Baseline
- Integrations
- Trackers
- Documents
- File Releases
- GitAgile™ – Enterprise Version Control
Baselines

Here’s what is new with TeamForge Baseline:

• Create New Baselines from Approved Baselines
• Support for index.html File in Baseline Packages
• Export to Excel and Compare Baselines
Baselines – Create New from Approved

You can now create a new Baseline from an approved Baseline by going to the Baseline option of the Project menu and selecting the desired baseline from the list of approved baselines and clicking Create.

All but the Name and Description fields are auto-filled with data from the source Baseline being cloned.

- Enter a Name and Description
- Update any filters
- Click Preview to review then Create to complete the action
Baselines – Support for index.html

With this release, 19.2, both index.html and index.pdf files are generated with all Baseline packages.

The index.pdf and index.html files show the list of all Tracker artifacts, Documents, File Releases, Source Code Repositories, Binaries and External Baselines that are included in the Baseline or Project Baseline from which the package was generated.
Baselines – Support for index.html

The Compare Baselines page can accommodate up to 10,000 records while Excel is not limited

- Use the Export to Excel button at bottom right
- A new site-options.conf token, BASELINE_COMPARE_ROOT_FOLDER, is added to configure the location where the Excel file is generated and stored when you export the diff
Integrations

Here’s what is new with Integrations:

• TeamForge – Nexus 2 Integration is No Longer Supported
• TeamForge – TestLink Integration via the Webhooks-based Event Broker
• CollabNet TeamForge Maven Deploy Plugin
Integrations – Nexus 2 Integration

The TeamForge – Nexus 2 Integration is no longer supported
If you currently have the TeamForge-Nexus 2 integration:
• Upgrade to Nexus 3
• Integrate TeamForge and Nexus 3
Integrations – TestLink Integration

- In addition to the TeamForge-Jenkins integration and the TeamForge-JIRA integration, TeamForge Webhooks-based Event Broker now supports TeamForge-TestLink integration.

- TeamForge-TestLink integration using EventQ is no longer supported

- A new TeamForge-TestLink integration plugin, colalbnet-testlink-1.0.3 is available, which tracks and synchronizes requirement and defect tracker artifacts between TeamForge and TestLink via TeamForge Webhooks-based Event Broker

**NOTE:** TeamForge 19.2 supports integration only with TestLink 1.9.17 and later
Integrations – Maven Deploy Plugin

- Use the CollabNet TeamForge Maven Deploy Plugin to notify TeamForge (via the TeamForge Webhooks-based Event Broker) about the binary artifact deployment details.
- Post upgrade to TeamForge 19.2 existing binary artifact data must be migrated from the EventQ database to the TeamForge database.
Trackers – Show Pending and Obsolete Releases

A new check box, **Show Pending/Obsolete releases** allows selection of a pending or obsolete release for the **Reported in Release** and **Fixed in Release** fields.

Pending and obsolete file releases are greyed out to distinguish them from active file releases.
Here’s what is new with Documents:
- Details page has a new look
- Open Document command button removed
- Document review cycle message now shown on Review tab
- Review tab UI has a new look
Documents – Details Page

The Document Details page has been revamped for better usability. The existing command buttons such as **Monitor/Stop Monitoring**, **Edit/Update** and **Users Monitoring** are replaced with icons and are grouped on a button bar.
Documents – Open Document Command

The **Open Document** command button has been removed from the **Document Details** page.

To open a document, use the active link in the **Name** field.
Documents – Review Cycle Message

The descriptive message entered when a Document review cycle is started is now shown in the **Review** tab of the **Document Details** page for convenience.
Documents – Review Tab

The **Review** tab has been refreshed to align its look and feel with that of the **Documents Details** page

<table>
<thead>
<tr>
<th>Icon</th>
<th>Shown in...</th>
<th>Signifies...</th>
</tr>
</thead>
<tbody>
<tr>
<td>😞</td>
<td><em>STATUS</em> column</td>
<td>Review is open/not started</td>
</tr>
<tr>
<td>✔</td>
<td><em>STATUS</em> column</td>
<td>Review is closed/completed</td>
</tr>
<tr>
<td>😞</td>
<td><em>REVIEWERS</em> column</td>
<td>Review from these reviewers is mandatory</td>
</tr>
<tr>
<td>😞</td>
<td><em>REVIEWERS</em> column</td>
<td>Review from these reviewers is optional</td>
</tr>
<tr>
<td>🌱</td>
<td><em>REVIEWERS</em> column</td>
<td>Avatars of reviewers</td>
</tr>
<tr>
<td>✔</td>
<td><em>REVIEWERS</em> column</td>
<td>Review completed by the reviewer</td>
</tr>
<tr>
<td>😞</td>
<td><em>REVIEWERS</em> column</td>
<td>Review not completed by the reviewer</td>
</tr>
</tbody>
</table>
File Releases – Obsolete Status

To mark file releases that are no longer used, a new **Status** of **Obsolete** has been added to the **Status** pick list on the **Edit Release** page.
Here’s what is new with GitAgile™:

• Git Repository Creation Simplified
• Import Git Repositories from the Code Browser UI
• Add Files to Git Repository from the Code Browser UI
• Show Old and New Images in Commit and Code Review Diffs
• Active-Passive High Availability Setup for Gerrit no longer supported
• History Protection Email template replaced with Closure Templates (Soy)
• Miscellaneous fixes
GitAgile™ - Repository Creation

Creating a Git repository has been simplified by removing some of the tasks (such as setting up the review rules) from the Create Repository page.

Now, review rules can only be configured from the **Settings > Policies** tab of the repository after the repository has been created.

Once a “Pull Request” category Git repository is created the **master** branch becomes the default protected branch.
GitAgile™ - Import Repositories

With 19.2, you can now import external public Git repositories into TeamForge from within the Code Browser UI using the **Import** tab.

![Import tab screenshot](image)
GitAgile™ - Add Files to a Repository

You can now add files to a Git repository from the View tab of the Code Browser UI with the new Add a file to Repository icon.

- Only one file can be added at a time
- Existing files can be uploaded or new files can be created
- Files added or created are added to the repository after a direct commit or after a code review
The following are additional updates with TeamForge 19.2:

- Old and new images are now shown in commit and code review diffs for merged requests
- Active-Passive High Availability Setup for Gerrit is no longer supported
- The Velocity Templates used for history protection email notifications have been replaced by Closure Templates (Soy)
TeamForge 19.1 Release Focus

- TeamForge Baseline
- Trackers
- GitAgile™ – Enterprise Version Control
Release Focus - TeamForge

With Release 19.1 of TeamForge we have focused on the following areas for enhancements, changes and additions:

- TeamForge Baseline
- Trackers
- GitAgile™ (formerly SCM)
Baselines

Here’s what is new with TeamForge Baselines:

- Draft Baselines
- Import Source Code and Binary Repositories from Project Baselines
- Include External Baselines in Baseline Packages
- Group Baselines Awaiting Review
- Group Binary Repositories by Nexus Version
- Support for index.pdf File in Baseline Package
- Auto Refresh Baselines and Package Lists
- References to External Baselines in Projects Created from Project Baselines
Draft Baselines provide easy identification of baselines that may be awaiting more details or other input. In other words, not yet ready for use.

- You can now save drafts of baselines
  - A **Save As Draft** button has been added to the Create Baseline and Create Project Baseline pages
  - The draft can later be edited or deleted
  - To view the draft, use the **Draft** option of the Baselines menu
Baselines – Repository Imports

- When creating a Project from a Project Baseline, the baseline’s Source Code and Binary repositories may now be imported into the new Project.

- The Create New Project page now has the following options:
  - Include Source Code: This option displays if the Project Baseline includes source code repositories.
  - Include Binaries: This option displays if the Project Baseline includes binary repositories.
Baselines – Include External Repositories

When generating a new Package, External Baselines which are included in a Baseline or Project Baseline can now be included as part of the Baseline/Project Baseline package.

- The included External Baselines are available as TAR files in the baseline package
- On the Generate Package page, select External Baseline from the Select Component list
Baselines – Pending Review

Now Baselines pending review can easily be viewed in one list using the Pending Review option of the Baselines menu.

- The number of baselines awaiting review and approval is shown next to the option, in this case, (25).
Baselines – Binary Repositories

• Nexus binary repositories are now grouped by the Nexus version (Nexus 2 or Nexus 3) on the Create Baseline, Create Definition and Project Baseline Definition pages to help you quickly identify and select the required repositories.
Baselines – Baselines and Trackers

• A new tracker, External Baselines, is created automatically on all projects created from Project Baselines that include one or more external baselines.
• An artifact is created for each external baseline included in the Project Baseline
Baselines – Baselines and Trackers (cont.)

- These newly created External Baseline artifacts include a link to the External Baseline in their descriptions in the format of “baseline id:baseline name”

Use this link to view the External Baseline from within its native project.
Baselines – More

• The new index.pdf file created during baseline package generation replaces the index.html file to better manage the large volume of data associated with baselines that have a large number of objects

• Auto Refresh Baselines and Package Lists
  • Baselines list page is automatically refreshed every minute if baselines with a status of Creation in Progress are being created in the background.
  • The packages list on the Packages tab of the View Baseline and View Project Baseline pages is automatically refreshed with the same cadenced if packages are being created in the background.
  • Both baselines and package may be manually refreshed using the Click to refresh option
Trackers

Here’s what is new with TeamForge Baselines:

• Drag and Drop Files to the Add Attachments Dialog Box
• Mandatory Fields without Default Value
• View Progress of File Uploads
Trackers – Drag and Drop Attachments

Attachments may now be added to an artifact using the drag and drop technique in the Add Attachments dialog box of the Attachments tab.
Trackers – View Progress of File Uploads

When you attach files to an artifact, a file upload progress indicator displays on the Create Artifact, View Artifact pages and the Add attachments dialog box.
Here’s what is new with GitAgile™:

• GitAgile Enterprise Version Control
  • Mass Configuration of Repository Policies within a Project
  • Quality Gates for Protected Branches
  • Tree View of Git Tags
You can now apply a specific set of policies to more than one repository

- Go to the *Repositories* tab of the *Source Code* option of the *Project Home Menu*
- Select the repositories for which you want to set the policies
- Click *Settings*
- Use the toggle button to enable or disable the settings

**Toggle the settings and click Review**
GitAgile™ - Repository Policies (cont.)

- Next, review the policies and if they meet your needs, click **Apply** to set the policies for all of your selected repositories.
GitAgile™ - Quality Gates for Protected Branches

Quality gates can now be enabled for protected branches in a TeamForge project.

- Create a change detail filter and set the branch pattern to annotation "@protectedBranches" in the `rules.pl` file
  - This filter reads all the protected branches and enforces the configured submit rule to these branches
  - For example, you can create the rule found below to block any submission to protected branches
The Tags tab now has a tag labeled Tree View which displays the tags of a given Git repository in a tree structure.

- Select a tag from the new tree view to see its details on the right side of the tree view.
- Tags are slash-delimited in breadcrumbs.
- The example below showing tag 1.0.0.1 can be found by expanding the build, release and subrelease folders.
TeamForge 19.0 Release Focus

- TeamForge Baseline
- Trackers
- GitAgile™ – Enterprise Version Control
Release Focus - TeamForge

With Release 19.1 of TeamForge we have focused on the following areas for enhancements, changes and additions:

• TeamForge Baseline
• Trackers
• GitAgile™ (formerly SCM)
Baseline

A Project Baseline is a baseline created on a project at a given point in time. Once you have Project Baselines created, you can kick start new projects from Project Baselines and proceed from when and where the Project Baselines were created in the past. As a general practice, Baselines are typically created to commemorate a release or delivery.

With a Baseline license, you can:
- Create Projects from Project Baselines
- Monitor Baselines
- Create Baseline Definitions and Include External Baselines
- Generate Baseline Packages
Baselines – Baseline Packages

- Generate Baseline Packages from an approved Baseline or Project Baseline
- Baseline Packages can include:
  - Artifacts
  - Documents
  - Git or SVN Source Code Repositories
  - File Releases
  - Nexus Binaries
- Download Baseline Packages to share with stakeholders or to extract the contents
Baselines – Creation and Use

- Create Projects from Project Baselines
  - Baseline projects at important milestones creating a snapshot in time and progress that can be used to create new projects
    - Approve Baselines to allow their use in creating new projects
    - Restart projects from a previously baselined point in time
    - Compare two Baselines created in distinct timelines
    - Begin Monitoring Project Baselines upon creation

- Include multiple Baseline definitions within Baseline Definitions and Project Baseline Definitions
  - Include External Baselines (Baselines from other TeamForge projects)
  - Create as many Baselines as needed
Baselines – Creation and Use (cont.)

- Upon creation of a baseline TeamForge objects that are included in that baseline are associated with the baseline to provide traceability.
  - Configuration items, or TeamForge objects included in the baseline are Trackers, Documents and File Releases.
  - The new Baselines tab in Artifacts, Documents and File Releases shows the baseline(s) associated with the object.

View associated baselines on the Baselines tab

Click the active link to view the Baseline details
Baselines – Creation and Use (cont.)

- Use the Jump To feature on the main navigation bar to go directly to the desired baseline.
  - Note that the object ID for the baseline has a prefix of **bdef**.
Integrations

- TeamForge 19.0 supports Nexus 3 Integration
- The EventQ-based TeamForge – Jira integration has been replaced with a new plugin version (1.0) which can be configured to notify TeamForge of Jira issues (work items) via the TeamForge Webhooks-based Event Broker.
- A newly enhanced Add New Tool page is now available to link/integrate External Applications
  - The Add New Tool page remains available in the Project Admin menu > Tools > Add New Tools page
- With 19.0, the TeamForge-Git integration is based on Gerrit version v2.15.10
SCM – Replicas Tab

- With TeamForge 19.0, SCM Admins can take advantage of the new Replicas tab in the Repositories list to easily and efficiently replicate repositories.

- The **REPLICAS** tab lists all the available repositories and replica servers in a tabular format. Simply select or clear the check boxes to enable or disable repository replication on the available replica servers.
SCM – Internal Code Browser

- Open Code Reviews now have check boxes for all files listed in the Files tab.
- Check the box to mark files as reviewed
- When you open a file, review it and close it the checkbox will be selected
SCM – Internal Code Browser (cont.)

- You can now reply to comments added to files during code reviews.
  - Comments become a conversation/discussion during code reviews.
  - Quote comments while replying to other’s comments
  - Mark comments as Done.
SCM – Internal Code Browser (cont.)

- View the entire diff on the same page using the active link on the Files tab

![Screenshot of SCM interface showing files and commit message]

- Click a filename to open that file in the Change Navigator, or view the entire diff.
Now, code reviews can be marked as **Private** or **Work In Progress (WIP)**
- Use this new feature to collaborate with others in private on experimental changes
Every tab on an SCM page in TeamForge can now be identified by a unique URL
  • Share the URL to allow others to go directly to the specific page with the same tab selected

Now, with TeamForge 19.0, commits may have multiple tags
  • Each tag may have its own note pointing to a single commit
TeamForge 18.3 Release Focus

- Baseline
- SAML Authentication
- Configure Application
- My Workspace
- Integrations
- Tasks
- SCM/Git/Gerrit/Subversion
Release Focus - TeamForge

With Release 18.3 of TeamForge, we have focused on the following areas for enhancements, changes and additions:

• Baseline
• SAML Authentication to access non-web applications
• Configure Application
• My Workspace
• Integrations and Deprecations
• SCM/Git/Gerrit/Subversion
Baseline

- TeamForge 18.3 brings you the release candidate of TeamForge Baseline.
  - Allows you to Create, Define and Manage project baselines
  - Includes custom Attributes and Statuses to best fit your needs
  - View the Baseline feature topics at docs.collab.net/teamforge183/baseline-overview.html

- Compare Baselines feature is supported in:
  - Google Chrome
  - Microsoft Edge (Not IE)
  - Mozilla Firefox
SAML Authentication – Non-web Applications

Now, in SAML-enabled environments you may access non-web applications such as Git, SVN and other CLI applications using your TeamForge credentials.

- You must have an existing TeamForge Account or create a new one.
- When creating new TeamForge accounts in a SAML-enabled environment, you will be redirected to the third-party IdP where upon successfully entering the SAML user credentials you will then be taken to the Create TeamForge Account page.
- Existing TeamForge users may reset their password using the Forgot Your Password option.
Configure Application – Site Admin Function

Local Users and Site-Admin Created Users

• In the past, site administrators were able to perform the following two tasks, designate users as local users and manage user accounts and passwords, by enabling a single site option ALLOW LOCAL USER (System Tools > Configure Application).

• With 18.3, the Site Admin may now manage these two tasks distinctly, the ALLOW LOCAL USER parameter is now replaced with two new site options, ENABLE LOCAL USER and ENABLE ACCOUNT MANAGEMENT.
Self Registration

- This is a new site option added in TeamForge 18.3. If LDAP is enabled as an IdP, the site option **ENABLE LDAP SELF REGISTRATION**, which is enabled by default, redirects those who try to log on to TeamForge without a user account, to the **Create TeamForge Account** page.
- To prevent the users from creating an account, the site administrators can disable this parameter. If the parameter is disabled, an error is thrown when users try to log on to TeamForge.
Configure Application – Site Admin Function (cont.)

Self Registration

• This is a new site option added in TeamForge 18.3. If LDAP is enabled as an IdP, the site option **ENABLE LDAP SELF REGISTRATION**, which is enabled by default, redirects those who try to log on to TeamForge without a user account, to the **Create TeamForge Account** page.

• To prevent the users from creating an account, the site administrators can disable this parameter. If the parameter is disabled, an error is thrown when users try to log on to TeamForge.
My Workspace – My Artifacts Widget

Now, in TeamForge 18.3 you can now search artifact titles for specific keywords and filter them.

- Click the **Title** header on the My Artifacts widget and type your keyword to view the list of matching artifacts as you type.
My Workspace – Monitoring

18.3 allows you to filter and toggle Monitoring options

- To view artifacts that you are monitoring using the **Include Monitored by Me** option.
- Use the Edit widget configuration icon (⚙️) to set the **Include Monitored by Me** check box.
- You can toggle between Monitoring (🔔) and Not Monitoring (🔔) by clicking on the Monitoring icon in the list.

- **NOTE:** The **Assigned To** and **Created By** fields will be not be shown, when you select the **Include Monitored by Me** check box.
Integrations and Deprecations

- TeamForge 18.3 supports Nexus 3 integration for binaries.
- TeamForge now comes with a native webhooks event broker for integrations.
  - Currently only the TeamForge- Jenkins integration is supported.
  - More integrations are in the pipeline.
- Tasks tool has now been removed from TeamForge 18.3.
  - Legacy data continues to exist in the TeamForge database.
SCM/Git/Gerrit/Subversion – In Line Editing

TeamForge 18.3 now allows inline-edit on source files in Git and Subversion repositories for which code review is not enabled.

- Simply **Browse** and **Open** the file on the view tab.
- Click **Edit** to make your in line changes and **Save**.
SCM/Git/Subversion – Filtering Changes

You can now filter commits on the Changes page by log message, author or by the committer.

- Just click **Filter** and type a keyword to search the log message or type the author or committer name and click **Done** to display the filtered list.
- You can clear the filter criteria anytime.
SCM/Git/Subversion – Find Files

- With the new **Find File** feature, to quickly find a file in a repository, just type the keywords and the results are shown instantly as you type.
  - Use the Find File icon (🔍) to initiate the search.
  - Search results are shown as you type.
SCM/Git/Subversion – Git Blame

- You can now view Git blame prior to a particular change.
  - Browse and view a file in a Git repository, select the **Annotations** check box and click the View Git blame icon.
SCM/Git/Subversion – Misc. Updates

TeamForge 18.3 brings the following updates to SCM:

- You can now view the PDF files in Code Browser.
- You can view the image files stored in Git LFS. Supported formats: GIF, JPEG, and PNG.
- The existing download tab is now replaced with a new **Download** button, which appears next to the **Edit** button on the Code Browser. Click this button to download the raw source files.
TeamForge 18.2 Release Focus

- TeamForge VersionOne Integration with ALM Connect
- Baseline Beta
- Tracker Usability Upgrades
- Security
- SCM/Git/Gerrit
Release Focus - TeamForge

With Release 18.2 of TeamForge, we have focused on the following areas for enhancements, changes and additions:

- TeamForge VersionOne integration with ALM Connect
- Introduction of the Baseline Beta
- Tracker Usability Upgrades
- Security
- SCM/Git/Gerrit
Integration with ALM Connect

- TeamForge 18.2 brings expanded ALM capabilities and coverage by integrating with ALM Connect.
- ALM Connect integrates all of your ALM tools into VersionOne, providing Enterprise ALM, Traceability, Reuse of Existing Assets and Automated Error Prevention such as resolving Data Synchronization Errors.
- With VersionOne, TeamForge projects gain better Agile project practices and coordination across environments.
Baseline Beta

- A Baseline in TeamForge represents an approved snapshot of selected configuration items from a given TeamForge project at a given point in time.
  - You can create a Baseline when you release or deliver a product or when you accomplish specific milestones in your project.
  - Such a Baseline includes key data that describes or helps identify the work items in the same state as it existed at the time of creation of the Baseline.
  - Baselines, once created, cannot be modified.

- Because this is a Beta release, it should not be used in production environments.
Tracker Usability Upgrades

- Floating buttons have been added to the **Create Artifact** and **Update Artifact** pages.
  - You no longer have to scroll all the way to the bottom of the page to perform common functions such as saving your changes.
Tracker Usability Upgrades (cont.)

- Some of the command buttons have been replaced with new icons (grouped in a button bar) on the **Update Artifact** page.
  - These icons let you copy an artifact’s URL to the clipboard, edit an artifact, start/stop monitoring an artifact, and clone an artifact.
  - An ellipsis indicates that there are more options.
  - The monitoring icon (bell) toggles between blue (monitoring) and gray (not monitoring).

- **Top** and **Back** keys have been added to allow a quick return to the top of a comment list and to return to the previous page, respectively.
Security

- Site Admins can enable the inclusion of a **DKIM** or DomainKeys Identified Mail signature in the headers of all outgoing TeamForge emails to authenticate all outbound emails against email spoofing.
- Query logging may now be toggled On or Off.
SCM/Git/Gerrit

- A new **events-log** plugin has been added.
  - The **Jenkins Gerrit Trigger** uses this plugin to make sure that the system automatically retriggers CI verification for any missed events during Jenkins downtime and the corresponding builds are triggered.

- A new rule has been added for enhanced commit governance.
  - This rule enforces that the artifact and the commit must be in the same TeamForge project.
SCM/Git/Gerrit (cont.)

- Improved user experience with review rules
  - Active review rules are displayed on the **Actions** panel.

- Review rules description is added as a tooltip on the **Actions** panel. The tooltip describes which rule is violated and what steps need to be performed moving forward.
Cloning with Submodules in Code Browser

- Enables recursive cloning of submodules with this system-defined cloning command.

```bash
git clone -- recurse-submodules ssh://mandersson@forge-git.collab.net:29418/masterfoobar
&& cd "masterfoobar" && git config user.name "Miikka Andersson" && git config user.email "mandersson@collab.net" && scp -P 29418 mandersson@forge-git.collab.net:hooks/commit-msg .git/hooks/
```
SCM/Git/Gerrit – Code Browser (cont.)

- Context-Specific Cloning
  - Enables the users to checkout exactly the same revision/branch/tag that is being viewed on Code Browser, when cloning a repository.

![Clone This Repository dialog box with command examples](https://example.com/clone-dialog.png)
Show only files with review comments

- By default, all files with or without the code review comments are shown on the **Files** tab view.
  - Select the check box **Commented files only**, if you want to see only the list of files that have review comments, enabling the users to checkout exactly the same revision/branch/tag that is being viewed on Code Browser, when cloning a repository.
Review comments to unchanged lines of code
  • Code review comments, added to lines of code that have not been modified as part of the code change, are now visible in the UI.

Hide/Show details for code review comments

Link to a single line of code or a range of lines
  • Linking capability to enable you to refer to a line of code or a range of lines in any revision of the file.
  • Allows toggling visibility for long review comments (having lot of log snippets or images) using the Expand/Collapse option.
SCM/Git/Gerrit – Code Browser (cont.)

- Option to block creation of new repositories
  - Prevent the creation of new repositories on selected SCM servers, thus enforcing the repositories to be created on servers with enough space.

- Option to prefix repository names with project
  - Enforce project names to be added as prefix to new repositories created on a specific SCM server allowing different projects to have repositories with the same name.
TeamForge 18.1 Release Focus

- LDAP
- Tracker Enhancements
- Documents Update
- SCM/Git/Gerrit
- Also of Note
Release Focus - TeamForge

With Release 18.1 of TeamForge, we have focused on the following areas for enhancements, changes and additions:

- LDAP
- Tracker
- Documents
- SCM/Git/Gerrit
- Also of Note
LDAP – Multiple User Accounts

In SAML and SAML+LDAP environments, if you have multiple user accounts mapped to one email address, you will be redirected to an intermediate login page before the third party IdP for authentication.

In this intermediate login page, you can see the list of accounts associated with your email address. Select one of the user accounts from the list, which would be the default user account used for authentication by the third party IdP for your subsequent logins.
On sites with LDAP/SAML/SAML+LDAP integrations, site administrators can designate select users that do not have a SAML or LDAP account as local users.

- Local users can log on to TeamForge using just the TeamForge credentials, without needing SAML/LDAP/SAML+LDAP authentication.

The **ALLOW LOCAL USER** site setting enables the **Local User** check box on the **Create User** and **Edit User Information** pages (Site Admin).

Site Administrators can manage user accounts and passwords in a SAML and/or LDAP enabled site if **ALLOW LOCAL USER** is enabled.
Trackers – Webhooks

- Project Admins can now create webhooks to generate events whenever an artifact is created, updated, moved, cloned, or deleted using the Project Admin menu’s Webhooks option.

- Choose **Create**; provide a Name, URL, and Description, then select the triggering events to set up the new webhook.

- Choose **Edit** to modify an existing webhook from the list.

- Choose **Delete** to remove a webhook from the project.
Trackers – Planning Folder Freeze

- Planning Folder Status values can now include **Freeze**.
- Frozen folders are indicated with a dot on the folder icon in the Planning Folders list.
- The **Freeze** value must first be added by the Project Admin in the Planning Folder Settings Option.
Trackers – Mark Down Editor

- A new Markdown editor has been introduced for the Description and Comments fields of tracker artifacts.
- You can now format your content with this wiki-like markdown syntax.
Trackers – Improved Search

- Tracker searches now permit the selection of one or more Planning Folders and Teams.
Trackers – More Enhancements

- With version 18.1, TeamForge has enabled the Filter Columns function for all system-defined fields within the Planning Folder view.
- All **Comments** in a tracker artifact may now be edited, rather than just the latest.
- When replying to an email generated by an artifact update, the original email text is no longer included in your reply, streamlining the communication.
Documents – Associations to Versions

TeamForge objects (tracker artifacts, source code commits, file releases, etc.) may now be associated to specific Document versions providing enhanced traceability.

Using the Version Listing in the Documents tool, select the version to associate.
• If no version is selected, the current Active Version will be associated.
SCM/Git/Gerrit

Using the **Co-authored-by:** information in the commit message, the co-authors are included in the Authored By: information in the changes list of the TeamForge Code Browser.

**Syntax:**
- Co-authored-by: User Name <useremail>
SCM/Git/Gerrit (cont.)

- With TeamForge 18.1:
  - The @mentions logic used in the review comments and description fields has been improved to include users that are added as reviewers already, which earlier was not the case.
  - Whenever a review is opened, the recommended reviewers list is shown immediately when the Add a New Reviewer field obtains focus.
  - Performance has been improved when viewing reviews and tags on repositories having large number of tags.
  - Deleted or rewritten branches are sorted in descending order to bring the most recent branches to the top of the list.
Also of Note

- HTML Notification Email Templates now display Avatars
  - For Assigned To field on artifact creation/update notifications.
  - For Created By, Updated By and Locked By fields on document create/update notifications.

- Auto Healing approach is now available to replace invalid XML records and make them available for the next ETL run.

- Site Admins may now set a new site option token enabling or disabling browser caching for better application performance.
TeamForge 17.11 Release Focus

- LDAP
- My Workspace
- File Attachments
- Trackers
- SCM / Code Browser / Git / Gerrit
Release Focus - TeamForge

With Release 17.11 of TeamForge, we have focused on the following areas for enhancements, changes and additions:

- LDAP
- My Workspace
- File Attachments
- Trackers
- SCM / Code Browser / Git / Gerrit
LDAP – Authentication

- TeamForge administrators can now set up LDAP as an IdP for user authentication.
- TeamForge 17.11 supports single LDAP server authentication.
- TeamForge now leverages the combined benefits of SAML-based single sign-on and LDAP authentication in one go. To enable both LDAP and SAML, TeamForge administrators must select the SAML+LDAP as the IdP.
My Workspace – Artifacts Widget

• You can now configure the Artifacts widget to filter and show artifacts from a select list of multiple projects, multiple users, multiple priorities, etc.

• The following filters of the Artifacts widget are now multi-select filters that let you further narrow your filter scope:
  • Project
  • Assigned To
  • Created By
  • Status
  • Priority
File Attachments

- Similar to tracker artifacts, TeamForge prevents restricted files from being attached for Documents, Discussions and Wiki components.

- You can now prohibit certain file types, that can potentially contain malicious content, from being uploaded to your TeamForge site. TeamForge Site Administrators can, at the site level, list the prohibited file types in the Configure Application page. For more information, see Configure your site's settings. When a user tries to upload a prohibited file type, the files are not uploaded and an appropriate error message is shown.
Trackers – Auto-Populate Fields

As part of your tracker workflow transitions, you can now set up auto-populate values for certain fields.
- Fields for auto-population are configured in the Project Admin > Tracker Settings page.

Select the **Status** field.
Click on the **Workflow** tab.
Choose the transition to prompt the auto-population.
Click on the **Advanced Transition** icon.
Fill out the details.
Trackers – Workflow Graphical Field

- A graphical view of role-based tracker workflows is now available for TeamForge project administrators.
  - The view is based upon the role selected.
  - Selecting a role from the drop-down list shows the possible workflow transitions for the selected role in a graphical view.
Trackers – Clones, Etc.

- Using the new Include Attachments check box in the Clone Artifact dialog, you can now clone a source artifact along with its attachments.
- Using the new Create as Child check box in the Clone Artifact dialog, you make the clone the child of the source artifact.
- Monitoring emails now include an "Unmonitor this Artifact" link.
- Monitoring emails now include a View Artifact link to go to the artifact details page of the artifact.
You can now configure Webhooks for Git, Subversion and CVS repositories both at the project level or for select repositories.
SCM /Code Browser/Git/Gerrit – Git Integrations

17.11.9 with 2.14.5.1

- Upgraded to major Gerrit version 2.14.5.1.
- HTTP webhooks functionality has been implemented to set up communication between TeamForge Git integration and the following products:
  - Lifecycle
  - Continuum
  - DLM 2.0
  - Any other tool that accepts HTTP notifications
- You can use TeamForge Code Browser UI for webhooks to setup webhooks for Git server, project or for particular repository level. You can also use the following products to configure webhooks on repository level:
  - CollabNet | VersionOne Desktop (latest development version)
  - GitEye (latest development version)
  - TeamForge Webhooks Configurator
SCM /Code Browser/Git/Gerrit – Git Integrations (cont.)

• 17.11.9 with 2.14.5.1
  • TeamForge Code Browser UI shows improved performance when repositories with substantial amount of tags are browsed.
  • Direct TeamForge UI links are returned in the responses of Git operations such as push-for-review.
  • Provides support for RHEL/CentOS 7.4.
  • Detects and applies appropriate ownership on vital integration files and folders.
  • Bug fixes
  • Monitoring service performance checks are done over proxy instead of localhost for clustered environments.
TeamForge 17.8 Release Focus

- Templates
- Email Notifications
- My Workspace
- File Attachments
- Tracker Usability

- SSO
- Reports
- API
- SCM/Code Browser/Git/Gerrit
- Install and Upgrade
Release Focus - TeamForge

With Release 17.8 of TeamForge, we have focused on the following areas for enhancements, changes and additions:

- Templates
- Email Notifications
- My Workspace
- File Attachments
- Tracker Usability
- SSO
- Reports
- API
- SCM / Code Browser / Git / Gerrit
- Install and Upgrade
Templates

The Create a Project Template from this Project page now lists Task Board and Kanban Board as candidates for inclusion in the new template.

Just check the boxes to include configured Task and Kanban Boards in the new template.
**Email Notifications**

- Email notifications to users assigned and users monitoring artifacts are now HTML format.

- Outlook for Windows, Outlook for Mac, and Office 365 Web Client are the email clients that support the HTML email format.
My Workspace – Artifacts Widget

- The Artifacts widget now comes with more filters to let you filter and create multiple lists of artifacts and add them to your My Workspace.
- Filter artifacts by **Assigned To** and **Created By** fields.
- Use fields such as Status, Priority and Tags for filtering.
- After selecting a Project, additional filters such as Planning Folder, Tracker and Teams become available.
File Attachments

- Control what file types may be attached to Tracker artifacts and uploaded to your site.
  - TeamForge Site Administrators can, at the site level, list the prohibited file types in the Configure Application page.
  - When a user tries to upload a prohibited file type, the files are not uploaded and an appropriate error message is shown.

Add a list of comma-separated file extensions to prevent those file types from being uploaded.
Tracker Usability

- You can now drag and drop files to attach them to an artifact.
- You can also browse and select multiple files and attach them in one go.
  - You can add any number of files by dragging and dropping them anywhere on the page or by adding multiple files using the Browse button provided that the overall size of the attached files not exceeding 25 MB.

**Warning:** You cannot attach prohibited file types.
SSO

TeamForge now supports Single Sign-on (SSO) authentication using SAML

- In addition to OAuth 2.0 (with Open ID Connect), TeamForge supports SAML (Security Assertion Markup Language) authentication and authorization protocol.
- SAML is an XML-based open standard developed by OASIS Security Services Technical Committee. It defines a framework to perform web browser SSO using secure tokens for exchanging security information between web applications.
Reports

- You can now refresh your reports to get the most recent data.
  - View the date and time when the report was last generated.
  - Clicking the Refresh icon fetches the latest available data from the respective data source (Operational DB, Datamart or EventQ).
The following API methods are newly available:

- TrackerApp.getAllowedWorkflowTransitionList2:
  - New method to retrieve workflow transition list with hidden fields.
- RbacApp.removeIntegratedApplicationPermission:
  - New method to remove integrated application permissions from a role.
SCM/Code Browser/Git/Gerrit

- You can now delete abandoned reviews if desired.
  - To delete an abandoned review, open the review in the code browser and click **Delete** from **Actions**.
TeamForge – Git integrations

- 17.8.23 with 2.14.6
  - Upgraded to major Gerrit version 2.14.6.
  - HTTP webhooks functionality has been implemented to set up communication between TeamForge Git integration and the following products:
    - Lifecycle
    - Continuum
    - DLM 2.0
    - Any other tool that accepts HTTP notifications
  - TeamForge UI for webhooks (implemented in TeamForge 17.11) is not backported. However, you can use the following products to configure webhooks:
    - CollabNet | VersionOne Desktop (latest development version)
    - GitEye (latest development version)
    - TeamForge WebHooks Configurator
SCM/Code Browser/Git/Gerrit – Git Integrations (cont.)

- TeamForge – Git integrations (cont.)
  - 17.8.23 with 2.14.6 (cont.)
    - Direct TeamForge UI links are returned in the responses of Git operations such as `push-for-review`.
    - HTTP requests were grouped by endpoint to improve HTTP statistics in the JavaMelody monitoring tool.
    - To delete an abandoned review, open the review in the code browser and click **Delete** from **Actions**.
TeamForge – Git integrations (cont.)

- **17.8.16 with 2.14.2**
  - Gerrit upgraded to 2.14.2 version that contains all corresponding fixes.
  - Git LFS File Locking API has been introduced that is used to create, list, and delete locks. For more information, see its documentation.
  - TeamForge Web UI now shows Gerrits reviews with deleted reviews.
  - Migrated AccountPatchReviews H2 embedded database to dedicated Gerrit database to improve the performance of the embedded database operations.
  - To improve security, SSL support has been introduced for Gerrit database connection.
  - TeamForge projects hierarchy is synchronized to enable project dashboards by default when connecting to TeamForge 16.7 and later.
  - Note: You can disable the dashboard by setting `teamforge.syncTeamForgeProjectHierarchy` to `false` in the gerrit.config file.
  - HTML templates are now used by default.
  - Upgraded to Java8 as part of Gerrit 2.14 update.
Install and Upgrade

- Changes to supported software versions
  - JRE 1.8.0_131
  - PostgreSQL 9.6.3
  - Subversion 1.8.18
  - Tomcat 8.0.44
  - RHEL/CentOS 6.9
  - post-install.py
    - The post-install.py script is no longer available. It's not required to run the post-install.py script during TeamForge install/upgrade as its functions have been moved into /opt/CollabNet | VersionOne/teamforge/bin/teamforge script's "deploy", "migrate", "bootstrap" and "initialize" hooks.
Install and Upgrade (cont.)

- **Gerrit database performance**
  - A new service, gerrit-database-performance, has been added in TeamForge 17.8-Git integration. This is installed by default with the gerrit-database. It is a second database that gerrit used to cache certain data for better database performance.

- **SELinux**
  - The teamforge script now takes care of switching SELinux to "permissive" mode during install or upgrade and switches back to its original mode once the install or upgrade is complete.
  - TeamForge implements SELinux policies for most of its services such as JBoss, Apache, ETL, Tomcat and so on. However, you can revert these policies (not recommended), if required.
Install and Upgrade (cont.)

- JAMES_ACCEPTED_RELAYS
  - SMTP authentication has been enabled for relays and as a result the JAMES_ACCEPTED_RELAYS token is no longer supported. Remove this token from the site-options.conf file while upgrading to TeamForge 17.8.

- teamforge script
  - Starting from TeamForge 17.8, /opt/CollabNet/VersionOne/teamforge/bin/teamforge has been linked to /usr/bin and therefore you can simply run the teamforge script from any path.
  - The teamforge provision command no longer prompts for a response before it bootstraps (during fresh TeamForge installation) or migrates (during TeamForge upgrades) data. In addition, there's no default answer configured with such prompts for user response. You must type either "y" or "N" to proceed.
  - The fix_data_permissions.sh script has been deprecated. You must use the teamforge apply-permissions command instead.
Reset the PASSWORD_CONTROL_EFFECTIVE_DATE token while upgrading to TeamForge 17.8

- Reset the PASSWORD_CONTROL_EFFECTIVE_DATE token. If not reset, the Password Control Kit (PCK) disables, deletes or expires user accounts immediately. You must pick a future date and set it to this token. For example, you can use the following logic and pick a future date:
  
  \[ \text{PASSWORD\_CONTROL\_EFFECTIVE\_DATE} = \langle \text{the day on which TeamForge upgrade is done} \rangle + \text{PASSWORD\_WARNING\_PERIOD} \]
Install and Upgrade (cont.)

- Restart the integration service post upgrade to TeamForge 17.8
  - If you are installing TeamForge on CentOS 6.9 with SELinux in "enforcing" mode and if you have CVS integration, you must restart the integration service after provisioning the services (teamforge provision).
    - teamforge restart -s integration

- `host:SERVICES` token validation
  - You cannot use an IP address in the `host:SERVICES` token (such as `1.2.3.4:SERVICES=`). teamforge provision fails if an IP address is used.
Install and Upgrade (cont.)

• Restart the integration service post upgrade to TeamForge 17.8
  • If you are installing TeamForge on CentOS 6.9 with SELinux in "enforcing" mode and if you have CVS integration, you must restart the integration service after provisioning the services (teamforge provision).
    • teamforge restart -s integration

• host:SERVICES token validation
  • You cannot use an IP address in the host:SERVICES token (such as 1.2.3.4:SERVICES=). teamforge provision fails if an IP address is used.
TeamForge 17.4 Release Focus

- My Workspace
- Configure App tool
- Tags
- Tracker Workflow
- SCM / Code Browser / Git / Gerrit
- Integrations
Release Focus - TeamForge

With Release 17.4 of TeamForge we have focused on the following areas for enhancements, changes and additions:

- My Workspace
- Configure App tool
- Tags
- Tracker Workflow
- SCM / Code Browser / Git / Gerrit
- Integrations
My Workspace

- You can create one or more dashboards to categorize and view data for different perspectives.

Choose from your configured Workspace Dashboards
Configure App Tool

- Use the Configure Application tool to define your site level settings.
- These settings are now configurable via the user interface.
- You need no longer manually update `site-options.conf` file and then recreate the TeamForge runtime for site level configuration changes.
The tagging functionality implemented for documents in TeamForge 17.1 has been extended to support tracker artifacts as well in TeamForge 17.4.

- Project members with CREATE/EDIT permissions can create new tags or add existing tags to tracker artifacts from the Create Artifact and Edit Artifact pages.
- You can add up to 10 tags to an artifact.
- You can add or remove tags to tracker artifacts when you search for artifacts within a single tracker or across trackers or during tracker mass update.
- You can also include "Tags" as one of the columns in the List Artifacts page.
Tracker Workflow

TeamForge 17.4 introduces Advanced Transition settings, which you can use to make specific fields as 'required' and also to show or hide specific fields when a status transition happens.

- When a user submits or edits the status of a tracker artifact, they see only the options that are allowed by the workflow.
- Advanced Transition settings are applied when you create or edit artifacts in a tracker and only when you edit artifacts in Planning, Task, and Kanban boards.
Two new tabs, Reviews and Search, have been added to the Source Code page (Project Home > Source Code).

- The Reviews tab lists all the Open, Merged and Abandoned reviews from all the repositories of the project.
- The Search tab lets you search for code on all the repositories in a project.
- In addition, the Repositories tab that lists all the available repositories in a project has been revamped for a better look and feel.
TeamForge – Git integrations

- 17.4.6 with 2.13.8
  - Git installer enhancements to support TeamForge 17.4 installer enhancements.
  - UI performance enhancements to support branches and Gerrit review that are substantially large in size.

- 17.4.11 with 2.13.9
  - RabbitMQ connections and threads retention issue fixed.

- 17.4.14 with 2.13.9
  - HTTP webhooks functionality has been implemented to set up communications between TeamForge Git integrations and the following products:
    - Lifecycle
    - Continuum
    - DLM 2.0
    - Any other tool that accepts HTTP notifications
SCM/Code Browser/Git/Gerrit (cont.)

- Repository Attachment Folder
  - You can now select a folder to upload code review and release notes file attachments.
  - All files attached to the repository are stored in the selected folder.
Integrations - Jira

- JIRA site administrators can now disable active JIRA-TeamForge project mappings in bulk (Administration > Add-ons > TeamForge Associations).
  - For use in staging JIRA upgrades to prevent triggering events back to TeamForge and polluting the production TeamForge event data store.
Integrations – Misc.

- TeamForge EventQ now supports TeamCity versions 9.0 and 10.0.
- [CTF-Nexus-Integration-Plugin-2.1.1](#) is now available.
TeamForge 17.1 Release Focus

- My Workspace
- Documents
- Tags
- Trackers
- SCM / Code Browser

- Code Search
- Email Notifications
- Install and Upgrade
- End-of-Life (EOL)
Release Focus - TeamForge

With Release 17.1 of TeamForge, we have focused on the following areas for enhancements, changes and additions:

- My Workspace
- Documents
- Tags
- Trackers
- SCM / Code Browser
- Code search
- Email Notifications
- Install and Upgrade
- EOL
My Workspace

- The My Workspace configurable display, introduced in 16.10 for SCM and Version Control licenses is now the default for all TeamForge users.
- Use configurable widgets to view recent projects, recent repositories, recent commits, items assigned to you, Git code reviews, project news and reports.
Documents – Requirements Management

TeamForge’s Documents Management tool has been enhanced to further support Requirements Management.

- The Project Admin can add custom fields and custom statuses.
- Document flex fields, tags and workflows are included in project templates.
Documents – Requirements Management (cont.)

TeamForge’s Documents Management tool has been enhanced to further support Requirements Management.

- Search for documents by their status and other user-defined flex fields.
TeamForge’s Documents Management tool has been enhanced to further support Requirements Management.

- Create Document workflows to manage status transitions
Tags

- Create tags and apply to objects (e.g., Documents, and soon, Tracker Artifacts)
  - Aid in classification of objects.
  - Mark ownership of objects.
  - Tag objects with milestones, releases and requirements, etc.
  - Any project member with Create/Edit permissions may create new tags although this is typically done by the Project Admin.
Trackers – Clone Association

- Associate Cloned artifacts with their Source artifacts.
  - Check the box to form the association.
  - View the association in the Association Viewer.
Trackers – Create Artifact

- New artifacts can now be created from the Tracker List.
  - Hover over the desired Tracker name to expose the + and click to create the new artifact.
  - No need to navigate deeper before creating the new artifact.
Trackers – Misc.

- You can now perform a cross-tracker search by artifact meta status (open or closed).
  - The Search All Trackers page (Trackers > Search Trackers) now has Status as one of the search criteria allowing you to choose All Open or All Closed artifacts across trackers.

- The List Artifacts page now limits the maximum number of rows in a page to 250 rows listed in a page.
  - This change optimizes performance for trackers with large numbers of artifacts.
SCM Code Browser – In Line Editing

For one or a few files, code changes can be done using the inline edit feature from within the code browser without having to clone an entire repository.

- Browse the repository, locate and open the file in the View tab
- Click **Edit** to open the file in the File Editor
- Make your changes
- Create code review and Publish your changes for review.
SCM Code Browser – In Line Editing

- For one or a few files, code changes can be done using the inline edit feature from within the code browser without having to clone an entire repository.
  - Make your changes
  - Create code review and Publish your changes for review.
SCM Code Browser – Adding Files in a Review

- You can now add or delete files to and from a Review using the Edit icon and the + or – symbols.
  - Once you select to Add or Delete, a dialog opens where you can type the file name to find matching results and continue with your desired operation.
SCM Code Browser – Git Tags

With TeamForge 17.1’s Code Browser enhancements, you can now create Git tags.

- Tag specific points in history as being important (e.g., release points.)
- Add Release Notes for the tagged revision.
- Use the tag to download source code as a zip/tar file.
- View the tag information in the Code Browser’s Changes and Graph tabs
Submit Whole Topic

- Bundle related changes (code reviews) by topic and submit the whole topic for review.
- No need to submit changes one-by-one.

Messages tab displays code review line comments.

- Code review line comments that were added to individual files are now readily accessible/viewable in the Messages tab.
- Line comments are now fetched from the files and are published in the Messages tab with links to open the corresponding files.
TeamForge commit validation policies, in addition to native TeamForge artifacts, are now applied to EventQ work items. For example, commit validation is now possible for a Jira artifact on sites with Jira integration.

Links are now available to download LFS objects from within the code browser. In addition, LFS authentication over SSH protocol is also supported.

Java Melody for Gerrit is now available to monitor key parameters such as the Gerrit server's CPU usage, memory consumption, active threads, and so on.
Code Search

- TeamForge is now equipped with its own code search function.

- The new search:
  - Replaces Black Duck Code Sight.
  - Is an integral part of TeamForge and is installed as such.
  - Works with both Git and Subversion repositories.

Note: No support for Black Duck Code Sight in TeamForge 17.1 (and later). Remove all Black Duck Code Sight tokens from your site-options.conf file while upgrading to TeamForge 17.1. TeamForge create runtime fails otherwise.
Email Notifications

- TeamForge no longer sends email notifications that trigger Out of Office replies.
  - This helps in preventing such Out of Office replies from being posted to artifacts and discussion forums.
Install and Upgrade – site-options.conf

TeamForge 17.1 includes major changes to site-options.conf configuration. The syntax for defining services running on a host, names (identifiers) of certain services and the syntax for defining the domain name have been changed in TeamForge 17.1.

- For more information, see site-options.conf.
- More details on the site-options.conf configuration instructions in TeamForge 17.1 install/upgrade documentation.

Important: No support for Black Duck Code Sight in TeamForge 17.1 (and later). Remove all Black Duck Code Sight tokens from your site-options.conf file while upgrading to TeamForge 17.1. TeamForge create runtime fails otherwise.
Install and Upgrade – site-options.conf

- TeamForge 17.1 includes major changes to site-options.conf configuration. The syntax for defining services running on a host, names (identifiers) of certain services and the syntax for defining the domain name have been changed in TeamForge 17.1.
  - For more information, see site-options.conf.
  - More details on the site-options.conf configuration instructions in TeamForge 17.1 install/upgrade documentation.

- Important: No support for Black Duck Code Sight in TeamForge 17.1 (and later). Remove all Black Duck Code Sight tokens from your site-options.conf file while upgrading to TeamForge 17.1. TeamForge create runtime fails otherwise.
Obsolete Tokens:
- BDCS_ADMIN_PASSWORD
- BDCS_ADMIN_USERNAME
- BDCS_HOST
- BDCS_SSL
- BDCS_TOMCAT_PORT
- BDCS_SDK_SEARCH_LIMIT_MAX
- BDCS_SSL_CERT_FILE
- BDCS_SSL_KEY_FILE
- BDCS_SSL_CA_CERT_FILE
- BDCS_SSL_CHAIN_FILE
- BDCS_SCAN_SOURCE_DIR_ROOT
- BDCS_INSTALL_PATH
- BDCS_PGSQL_HOME_DIR_ROOT
- BDCS_PGSQL_PORT
- BDCS_TOMCAT_MX_IN_MB
- BDCS_TOMCAT_SHUTDOWN_PORT

New Tokens:
- <hostname>:SERVICES
- <hostname>:PUBLIC_FQDN
- ELASTICSEARCH_JAVA_OPTS
Install and Upgrade – Misc.

- Changes to the supported software versions are as follows:
  - Tomcat 8.0.39
  - Subversion 1.8.17
  - JRE 1.8.0_112

- Scripts no longer available are as follows:
  - The CodeSightMigration.sh
  - The sofconv.py script

- SSL encryption is turned on by default:
  - SSL is enabled by default and a self-signed certificate is auto-generated. If you want to turn off SSL encryption for your site (not recommended), set `SSL = off`.
  - See TeamForge 17.1 install/upgrade instructions for more information.
The following End Of Life decisions have been made and implemented:

- No support for Black Duck Code Sight. However, TeamForge is now equipped with a homegrown code search utility powered by Elasticsearch (https://www.elastic.co/)
TeamForge 16.10 Release Focus

- Licensing Model
- My Workspace
- Documents
- Permissions
- Trackers
- SCM / Code Browser / Git
- End of Life (EOL)
Release Focus - TeamForge

With Release 16.10 of TeamForge, we have focused on the following areas for enhancements, changes and additions:

- Licensing Model
- My Workspace
- Documents
- Permissions
- Trackers
- SCM / Code Browser / Git
- End of Life (EOL)
Licensing Model

The new TeamForge license model, introduced in release 16.7 has been augmented with two new license types:

- **Collaboration** offers a range of collaboration tools such as Documents, Wiki and Discussions.
- **Trackers** offers Tracker capability including Trackers, Planning Folder, Teams, the Planning, Task and Kanban Boards, plus File Releases.
- **ALM** offers the full range of ALM tools and functions.
- **SCM** offers core Source Code Management tools and functions (ALM minus Tracker and Documents components).
- **Version Control** offers Source Code management, File Releases and Review tools.
- **DevOps** offers Package management (Application & Environment) and File Releases.
### Licensing Model

#### Tools Availability Matrix:

<table>
<thead>
<tr>
<th>Tools</th>
<th>ALM</th>
<th>SCM</th>
<th>Version Control</th>
<th>DevOps</th>
<th>Collaboration</th>
<th>Tracker</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agile Task and Planning Boards</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tracker</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Git/SVN Repository Management and Replication</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Code Review</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Build Automation</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Test Management</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>File Releases</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Binary Repository Management</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EventQ/Activity Stream</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Access Controls</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>
## Licensing Model (cont.)

**Tools Availability Matrix:**

<table>
<thead>
<tr>
<th>Tools</th>
<th>ALM</th>
<th>SCM</th>
<th>Version Control</th>
<th>DevOps</th>
<th>Collaboration</th>
<th>Tracker</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Workspaces</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Wiki and Discussion</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Document Management</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User Management</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flexible Process and Toolchain Templates</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reusable Dashboards</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Categories and Groups</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cross Project Visibility</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cross Project Reporting and Dashboard</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cross Project Search</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Licensing Model (cont.)

Tools Availability Matrix:

<table>
<thead>
<tr>
<th>Tools</th>
<th>ALM</th>
<th>SCM</th>
<th>Version Control</th>
<th>DevOps</th>
<th>Collaboration</th>
<th>Tracker</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site-wide Administration</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Custom Branding and Custom Integrations</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Onsite and Hosted Provisioning</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>SVN Auto Updates</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SVN Repo Backup and Monitoring</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td>✔</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
My Workspace

- A new My Workspace dashboard has been added for users with SCM or Version Control licenses.
  - Your display will depend upon your license type.
    - SCM and Version Control licenses display the My Workspace configurable dashboard which offers widgets such as "My Recent Projects", "My Recent Repositories", "Git Code Reviews", and "Project News".
    - Dashboard configuration consists of a page layout and a selection of widgets so you can configure your dashboard to provide the information you need in the display that works best for you.
    - ALM Licenses will continue to display My Page with tabs showing items Assigned to, Created by or Awaiting Approval from User.
The Documents list page has been revamped for usability, performance and scalability.

- Document folders are now loaded on demand, avoiding potential memory issues.
- Contextual menus have been added to create, delete, reorder and move folders speed up documents management tasks.

Hover over the folder name to reveal the cog icon.

Use the cog icon to open the context menu.
Permissions

- The User Role Matrix now has a smart search filter to make it easier to filter by name and assign roles.
- Use the arrow next to Name to sort the user list.
Trackers - @mentions

- Tracker artifacts now support @mentions.
  - Both Descriptions and Comments support @mentions.
  - Users called out in the @mentions are added to the monitoring lists if they possess at minimum View Artifact permissions.
  - @mentions may be used when creating or editing artifacts in Trackers Planning Folder List view, Planning Board, Task Board, Kanban Board, and Mass Update/Inline Edit modes.
  - To use an @mention, add the user’s ID after the @ (e.g., @tselman).
Trackers – Clone Artifact

- Tracker artifacts can now be cloned across Tracker types and across Projects.

1. Use the smart search for the Project name which is the target for the cloned artifact.
2. Then, select the appropriate Tracker from the Project’s Tracker list.
With Release 16.10, it is now possible to create a new branch from within the Code Browser using the Branches tab.

- Click **Create a New Branch**.
- Enter the Branch name and initial version.

Click **Create a New Branch** to open the dialog to enter the new branch name and initial version.
SCM/Code Browser/Git – Cherry Pick Commits

- You can now cherry pick and apply changes introduced by existing commits to another branch.
- Use this Cherry Pick function in TeamForge's native code browser to apply a commit in master to a release branch.
SCM/Code Browser/Git – Gerrit 2.13.2

- Based on Gerrit 2.13.2 vanilla Gerrit version: 2.13.2-89-gdb9c840

- Git LFS improvements:
  - Introduced system and repository level LFS configuration (CollabNet | VersionOne contributed to open source Gerrit configuration interface).
  - Migration from TeamForge 16.7 LFS configuration.

- Improved user experience by incorporating navigation from Gerrit review mails and events back to TeamForge UI.

- Major installer rework to adjust to the TeamForge 16.10 installer architecture:
  - Added Gerrit health check endpoint.
  - Default location of /gitroot moved to /opt/CollabNet | VersionOne/teamforge/var/scm/gerrit/gitroot.
  - Allow Gerrit database to run on a separate server.
Introduce Delete History Protection Refs plugin capability so that maintenance of history doesn't require Administrate Server capability anymore.

Packaging: Continued work on unifying RPMs and as a result the following packages were obsoleted:
- ctf-git-integration-NG
- ctf-git-integration-NG-migration
The following End Of Life decisions have been made and implemented:

- The "Discover Subversion Edge Servers" feature (Java applet-based) that lists all the Subversion Edge servers in your LAN has been removed from TeamForge 16.10 and later.
- TeamForge SOAP50 APIs and event handlers are no longer supported in TeamForge 16.10 and later. Instead, Customers can use the latest TeamForge SOAP/REST APIs.
- SSH tunneling is no longer supported.
- Project Tracker is no longer supported. domain_change_pt.py script has been deprecated.